
Access 2007: What’s New?

It has been a widely held belief that Microsoft Access has been neglected during many of the
upgrades to Microsoft Office over the years. However, with the latest release, Microsoft Access
2007, many changes have been made to the interface and the database engine, and integra-
tion with Microsoft Outlook 2007 has been added in the form of Collect and Update Data via
Email. It is also now possible, by downloading an add-in, to save objects to various formats,
such as PDF.

Several new data properties are available, and increased server capability in the shape
of Microsoft Office SharePoint Server 2007 has been added to Access—all adding up to a
major increase in attention by Microsoft to what is the most widely used desktop database
in the world.

Also new in Access 2007 is the increased focus on macros including new error control.
While this might surprise many developers, it will meet the needs of many power users who
place greater reliance on macros when creating Access applications. The new database tem-
plates are macro driven, and while they do contain VBA code, they are developed using
embedded macros. Another change, one long called for, is the redevelopment of the North-
wind example database traditionally available with Access. The latest version of this example
database, Northwind 2007, has been totally redesigned from the ground up and makes exten-
sive use of class modules for data interaction.

Already feeling forgotten by the Access development team, Access developers may not
appreciate some of the changes, particularly the shift in focus toward full integration with
SharePoint Server, but I hope this book can assist you in moving toward this new storage
medium and in familiarizing yourself with this new enhanced version of Access. This chapter
provides an overview of the changes facing you when you move to Access 2007. Detailed cov-
erage of the topics I touch on here will appear later in the book. For now, I just give you a taste
of some of the changes made to your favorite database application.

The biggest changes in Access 2007 are those that have been made to the JET database
engine, which has been referred to as ACE during the beta process by Microsoft. The new
engine is a private copy of JET used by the Office 2007 team and has been refined and added
to for Access 2007. The default database type is the ACCDB format created using Access 2007,
but MDB files are still supported in the new release. Table 1-1 shows some of the differences in
behavior when using both the new engine and Access 2007 as opposed to Access 2000/2003
MDB files.
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Table 1-1. Access 2007 and Access 2000/2003 Feature Comparison

Access 2007 Access 2000/2003

ACCDB file type Cannot be used

Complex data types Not available

Attachment data type Not available

Append-only memo fields Not available

Offline support for linking to SharePoint Not available

Linking tables to ACCDB files Not available

Encrypting with database password Not available

Linking to SharePoint Some data types not supported

Rich text support Not available (will appear as HTML)

Date picker Not available

Control layouts Independent controls

Linking to Excel 2007 Not available

Embedded macros Not available

Control auto-size Not available

Tabbed Document mode Not available

Navigation Pane Database Container

Custom groups in Navigation Pane Not available

Tables and View mode Not available

Ribbon Command bar

Saving imports and exports Not available

Improvements in filtering and sorting Not available

Save Database As command Not available

Sharing database on SharePoint Not available

Upsizing to SharePoint Not available

Trust Center Not available

New sorting and grouping Not available

Property Sheet Task Pane Not available

Creating schema in datasheet Table design only

Office 2007 Options Center Not available

Editable value lists Not available

Editing list items for combo and lists Not available

SharePoint Site Manager Not available

Form split view Not available

Search box Not available

Custom caption for navigation Not available
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The following features are only supported in the new ACCDB database file type:

• Complex data (multivalue data types)

• Attachment data type

• Append-only memo fields

• Compressed image storage for any picture property

• The ability to send an Access file as an e-mail attachment

• Full support for linked tables to SharePoint

• The ability to publish to SharePoint

• The ability to take SharePoint data offline

• The ability to create linked tables to other ACCDB files

• Rich text support

As you can see, there are many differences between this new version of Access and previ-
ous versions. Now that you’ve gotten a brief overview of some of the changes Access 2007
offers, let’s take a quick tour of the program, starting with the interface.

Access 2007 Interface
The first thing to hit you when you open Access is the new graphical user interface (GUI),
which is used not only by Access, but also by the entire Office 2007 product line. To be honest,
although it looks good, at first I preferred the old menu system. It took me some time to find
out where all my favorite menu options had gone. Once I got used to the new dynamic menus,
I again felt at home with Access. (The appendix at the back of this book maps the old menu
system to the new system.)

However, many users will instantly appreciate this new interface. One complaint I always
get from Access beginners is that, when the program first starts, they are left looking at a
blank database window wondering what to do next. This is no longer the case, as several “get-
ting started” templates come with the application, and many more can be downloaded from
Office Online at http://office.microsoft.com/en-gb/access/FX100487571033.aspx. Links to
the available template databases are provided within the Access 2007 user interface. At the
time of writing, the following templates are planned for Access 2007:

• Assets

• Contacts

• Events

• Issues

• Tasks

• Customer Service
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• Projects

• Marketing Projects

• Sales Pipeline Database

• Students

• Faculty

You can access the templates from the Access splash screen on startup or when clicking
the Office button and selecting File ➤ New. Links are also provided on the splash screen to
training resources, templates, and downloads.

In keeping with the Microsoft view of the world and tying in with the move toward Share-
Point Server, these templates are mainly tracking-type applications useful to some users, but
the developer and power user community will find them lacking in major functionality. How-
ever, it is possible to create custom user templates that focus on your own particular business
model. We will be looking at current templates and creating your own in Chapter 2. At some
point soon, a new tool will be available from the Access development team to make the tem-
plate creation process much easier: it will allow developers to avoid having to get to grips
manually with the underlying XML file and folder structures.

Templates provide both the developer and the user with a “getting started” opportunity,
and this in itself is to be welcomed. Figure 1-1 shows the new-look interface when Northwind
2007 is first opened and you have logged in.
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■Note Templates may also provide a new business opportunity for you. How many times have standard
users screwed up a database? Countless consulting projects can arise out of poorly designed applications.
There is nothing to stop developers from using the same techniques employed by Microsoft and Access
2007 to create and sell third-party templates for Access 2007. Worth considering?

The user selects the required application template from the interface (or opens an exist-
ing database) and follows the instructions for downloading and installing it as a working
database. Once you have a database open, the new user interface really takes hold. It uses 
a dynamic menu system called Ribbons. Ribbons and options available change to reflect the
task being carried out. A tabbed interface for database objects now makes it possible to have
several objects open at once—which can be either a help or a hindrance. Databases created
in previous versions open using the standard Access multiple document interface (MDI).

When creating a new database application, Access by default creates a blank table called
Table 1. This feature is designed to give the user a starting place when building applications,
but developers may find it extremely irritating! The new table determines the appropriate data
type as the user enters data, and it can and in all probability should be redesigned as usual in
Table Design view.

Navigation Pane Replaces Database Window
The database window is gone, replaced by a new highly customizable Navigation Pane. The
Navigation Pane can be organized by Access object, filtered by object types, or totally cus-
tomized by the developer or end user. Customized groups can be exported to and imported
from other databases, all more or less in the same vein as Access 2003. In this case, it is also
possible to group related objects together—for example, a table and all its related objects,
forms, queries, and reports.

PDF Support Added
PDF support was something long desired by Access developers who in the past relied on third-
party tools to provide this flexibility. Now, developers need no longer look to third-party
add-ins in order to publish PDF files, as this capability is now available using Office 2007. PDF
support must be installed by downloading a particular add-in from http://office.microsoft.
com/en-gb/access/HA101675271033.aspx.

■Note PDF support is available in all Office 2007 applications; it is not restricted to Access 2007.
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Access 2007 Ribbons
The new Office 2007 menu system is comprised of two types of Ribbon-based menu: regular
Ribbons, which will always be available, and dynamic task-based Ribbons, which are available
when completing a specific task. Many existing users of Access will at first find Ribbons some-
what confusing as they try and work out where all their old favorite commands have gone.
One or two older Access menu items are no longer available; for example, the Access Table
Wizard has been removed and replaced by a simple Ribbon command used to insert a new
table. The following are the new base Ribbon menus available from the main Access menu:

• Home tab

• Create tab

• External Data tab

• Database Tools tab

• Add-ins tab

Of course, many additional Ribbons are available to you depending on the task being car-
ried out. These are referred to as contextual Ribbons and are hidden or unhidden as required
when the application is running. The appendix at the back of this book contains details on the
available Ribbon commands within Access compared to those used in Access 2003.

As you may have gathered from the list of base Ribbon menus, the new menu system con-
sists of a set of tabs. Clicking a tab reveals groups that each contain a set of related commands.
For example, the Create tab contains a group providing commands used to insert a new table
(the Table group) and a group that gives you the option to add tables using prebuilt table tem-
plates (the Table Templates group). Figure 1-2 shows the Table Templates group.
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Figure 1-3 shows the Access Create Ribbon. The options are task based and therefore
grouped accordingly.

If you want to get to the heart of an Office 2007 Ribbon, it’s time to learn some XML,
because a Ribbon receives its structure from an XML file. We will be looking at Ribbons in
much more detail in Chapter 3, including customization. However, it should be said that cus-
tomizing Ribbons is a little removed from the ability of those who are used to creating custom
command bars in the Access interface. Many developers will rely on third-party tools to assist
in customization rather than take the leap into XML and .NET languages. This will be useful
for developers who have fairly simple needs, for example, turning off menu functions and per-
haps creating your own menu options (for instance, a drop-down list presenting a set of
reports to the user).

A third-party tool used to customize Ribbons has been developed by one of the Office 2007
beta testers and is available from http://pschmid.net/blog/category/ribbonx/. Chapter 3
demonstrates the functionality of Ribbons and the customization features available to you in
Access 2007. In the meantime, I strongly suggest you download the add-in. At the time of writ-
ing, there is no charge associated with this add-in. However, a developer’s version is also
available for a small charge. In my opinion, this is well worth the cost.

The new interface also contains a Quick Access Toolbar (QAT), which can be customized
with those menu options you use frequently. QAT options are globally available throughout
Access rather than as dynamic Ribbon options. This is a useful feature that can help a new user
get to grips quickly with the new menu structures. Microsoft recommends that the QAT not be
used by developers to position their own commands on the Ribbon. The QAT is designed to per-
mit users to add items they find useful from the existing Ribbon, rather than developers adding
their own items to the QAT programmatically. It is also possible that the QAT will change in fur-
ther releases of Access 2007, and developer changes made to the QAT may not be supported.

■Tip You can minimize the Ribbon to save screen space by right-clicking a tab and selecting Minimize
Ribbon from the context menu. To maximize the Ribbon, simply click one of the tabs.

Right-clicking a tab item and selecting Customize Quick Access Toolbar (QAT) will open
the Access Options dialog box from which any of the available Ribbon commands, controls, or
tools can be added or removed. The QAT can be customized for the current database only or all
databases opened using Access 2007. Figure 1-4 shows the default QAT before customization.
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For applications created in other versions, Office 2007 is backward compatible in as far 
as your “old” custom menus will still be available. It’s well worth noting that there is no object
model to permit you to interact with a Ribbon. In addition, little in the way of user customiza-
tion is available for standard users in terms of creating new Ribbons. For many, it’s a case of
being stuck with what you’ve got!

Access Options
The Access Options dialog box provides you with quick access to almost all the configurable
options available to you within Access 2007. Each set of options is grouped by a specific cate-
gory. Some of the options will affect Access only, while others apply to Office 2007 generally.
Rather than bore you with the standard options, the following list focuses on those that may
be important to you, new in this release, or useful in development.

Popular: Options that are most popular with users. Of course, as this has been decided by
Microsoft, it is a little off as the options available, Always use Clear Type, Screen Tip Style,
and so on, would not jump out at me as being the most popular options!

Current Database: Options that affect the currently open database, for example, options
to add an application title or icon, to turn off Layout view, and one option that will prove
useful to many developers, to turn on or off the Navigation Pane. Within the Current
Database options, developers can also indicate a custom Ribbon ID to use for this data-
base in place of the built-in Ribbons.

Datasheet: Formatting options for Datasheet view. Using this option, you can select fonts
to use, display of grid lines in forms, and default cell effects.

Object Designers: Options that you can set to affect how various design tools are config-
ured for Access. The options are in distinct groups as follows:

• Table Design

• Query Design

• Form Design

• Error Checking

Proofing: Encompasses several options including spell checking, grammar checking, and
autocorrection. Many Access developers do not use the autocorrection features available
within Access, as they can cause problems with database performance and have been a
longtime developer issue. However, it is believed that the performance issues surround-
ing autocorrection have been resolved with Access 2007.
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Advanced: Several options that can be set to deal with how Access interacts with your data
and users can interact with an application. The following option groups are available:

• Editing

• Display

• Printing

• General

• Advanced

Customization: Useful to help add or remove Ribbon options from the QAT using the
new Access customization dialog box. Users can place frequently used items on the QAT
in a similar way to working with command bars in previous versions.

Add-Ins: Listing of all add-ins currently being used by Access. This gives a quick overview
of any third-party development tools you happen to be using.

Trust Center: Accesses the Trust Center, one of those areas of Access 2007 you will either
love or hate. In all probability, many users will set the trust level to the lowest possible to
avoid all the nagging messages that could result when they open a database containing a
macro. The recommended approach from Microsoft is to leave the settings at their
default: full functionality. Two settings are available in the Trust Center: Show the mes-
sage bar in all applications when content has been blocked and Never show information
about blocked content. On my system, when I am writing, I turn them off. To be honest, 
I got fed up with getting a nagging message every time I went to do an example for this
book and found I had to choose Enable Active Content. Of course, I then realized I could
set a folder as a trusted location and resolve the issue that way. That has worked out OK
and is a much more sensible approach than turning off everything. Files placed into the
Trust Center will not be challenged by the Access security features that block active con-
tent. The following locations are marked as trusted when you install Microsoft Office
2007: \Program Files\Microsoft Office\Templates and \Program Files\Microsoft Office\
Office12\Startup.

Resources: Contains links to online resources to assist users when working with Access.
Links are available to the Office web site, interactive Office 2007 diagnostics, online help
and resources, software updates, and a contact Microsoft feature.

As you can see, there are many options, controls, and tools available to you to help with
customization of the program and your application without your having to resort to code.
However, all options will be available to the end user as well, and in Chapter 3 we will be look-
ing at specific approaches to help close these gaps in customization.

Access 2007 Tables
Tables in Access 2007 remain much as they were in previous versions of the application. There
is little that can be done to add or decrease the functionality of a basic table; however, some
new data types have been added to complement the ability of Access to deal with other appli-
cations (most notably SharePoint Server), and additional table properties have been provided.
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The data filtering ability when in Standard view has been greatly improved. The new inter-
face also permits multiple objects to open in either Design or Standard view using a tabbed
interface to move between items, for example, multiple forms currently opened. Figure 1-5
shows the new form interface with several form objects open.

Complex Data Types
Developers will notice that a new data type is now available in Access 2007 to support the use
of complex data types, for example, documents that have been associated with a database
record. This new data type, attachment, permits the user to store many different types of
information with a single database record without complex programming by the developer.

A property is also available when using lookup lists, Allow Multiple Values, that does
just as it says: it permits a user or developer to associate multiple data values with a single
field without having to resolve a many-to-many relationship. One of the main reasons for
this is a feature in SharePoint Server lists that allows you to associate multiple values with
particular data, for example, multiple developers assigned to a project. Behind such
changes is the need to fit Access into the same underlying schema as that used by Share-
Point. Another reason is the Microsoft focus on insulating Access users from the finer points
of database design, though how they can be expected to take advantage of this feature with-
out knowing what a many-to-many relationship is in the first place escapes me!

To support these new features and, of course, integration with SharePoint, two major
changes have taken place in Access 2007—a new data engine (ACE) and extensions to Data
Access Objects (DAO) have been added. It should be some consolation to know that under 
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the covers within the data engine a fully normalized relationship is created (that is, the many-
to-many relationship is resolved using standard normalization techniques). This relationship
is not currently available to you via the user interface. It has been strongly suggested during
the beta process that this functionality be provided to developers at the very least. At the time
of writing, access to this area is not available.

■Note Now before the relational purists jump out of whatever chair they are reading this in, it’s real
important to say that such changes are intended purely for the world of SharePoint. Now I know that’s all
fine in theory; we will begin to see hundreds of Access applications using these features, and for many
small users this will not be an issue. It will be a real issue in applications that are to be upsized to SQL
Server. Such fields will upsize but contain issues that we will need to resolve.

Multivalue Fields
Multivalue fields are not the same text fields in which users are permitted to key in several
values (for example, developer names). In this case the data is fully normalized, but within
the database engine as opposed to within the table structures. This can be seen especially
when it comes to working with these values via DAO and VBA.

This design addition is intended to shield the end user from the classic many-to-many
relationship and can be applied to the Lookup property and the attachment data type, intro-
duced earlier. Once the Allow Multiple Values property is enabled, a checklist is available
within the field that permits users to select one or more values from the presented list.

Activating the Allow Multiple Values Property
As mentioned previously, Allow Multiple Values is a new property that has been added to the
Lookup property, which has long been available in Access. In this case, by setting this property
to Yes, it is possible to permit users to select one or more data items to associate with a partic-
ular lookup field.

To activate the Allow Multiple Values property, you could, for example, create a new table
called Employees with standard fields (fldForeName, fldSurName, and so on) and a second
table named Tasks containing a new field named fldAssignedTo. In the field properties for
fldAssignedTo, you would click the Lookup tab, change Display As to Combo Box, and set the
Allow Multiple Values property to Yes.

Using the Attachment Data Type
The attachment data type permits the storage of multiple file attachments within a single field
and is a useful tool when working with documents and other resources. It is no longer neces-
sary to deal with API calls to open File dialog boxes or worse still save such objects within the
database file. Internally, the attachment is stored in a binary field, and the underlying relation-
ships are not exposed via the interface. There is no way to see the true nature of the
relationship via the GUI. To open an attachment, double-click the file name within the Attach-
ment dialog box.
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To illustrate this new data type, I will walk you through a short example.

1. Create a table named tblAttachment.

2. Create a single field with a data type of attachment, and name the field fldMyDocs.

3. Save the table.

4. Open the table in Standard view.

5. Double-click the attachment paper clip icon.

This opens the Attachment dialog box, which can be used to navigate to and select
required files.

6. Click Add.

7. Select a file name using the Choose File dialog box.

8. Click Open.

9. Click OK to close the dialog box.

Once finished, note that the field uses a standard attachment icon and shows the number
of files referenced.

To view the attachment, you would double-click the field cell containing the attachment
to open the Attachment dialog box. Using the dialog box, you can

• Add additional attachments.

• Remove attachments.

• Open an attachment.

• Save an attachment.

• Save the attachment under a new name.

In order to see the real effects of this additional data type, open the relationship 
window by clicking Database Tools ➤ Relationships. Look at the Attachment table,
particularly the Attachments field, and note the additional values: Attachments.FileData,
Attachments.FileName, and Attachments.FileType. These are revealed (as shown in 
Figure 1-6) by clicking the plus symbol beside the Attachment field name. The values are self-
descriptive: FileData refers to the file being stored, FileName is just that, the name of the file,
and FileType refers to the file extension.
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Let’s look at another example, this time using DAO to load an attachment located in
C:\AccessAttachments into tblMyDocs. The following code fragment loads a file from the fol-
lowing path, C:\AccessAttachments\test.doc.

■Note Remember to change the path and the file name to reflect your own setup before running this
example.

Public Sub loadfile()
Dim rsttblDocs As DAO.Recordset
Dim rstGetData As DAO.Recordset
Set db = CurrentDb
' Get the parent recordset
Set rsttblDocs = db.OpenRecordset("tblMyDocs")
' Put the parent record into edit mode
rsttblDocs.Edit

' Get the attachment recordset
Set rstGetData = rsttblDocs.Fields("fldMyDocs").Value
' Set first attachment to loaded picture
rstGetData.Edit
rstGetData.Fields("FileData").LoadFromFile ("C:\AccessAttachments\test.doc")
rstGetData.Update
' Update the parent record
rsttblDocs.Update
End Sub

Note the use of two recordsets: rsttblDocs to open the main parent recordset and rstGet-
Data to load the “child” recordset to permit access to the attachment field contained within
the parent recordset.

Filtering Tables
It has long been possible to filter data directly with an Access table, but this feature has
been enhanced in Access 2007. Tables now have a built-in sort-and-filter facility located to
the right of each field and indicated by a down arrow. It is possible to sort in ascending and
descending order and to filter any of the values being displayed. The filter type is dynamic,
changing according to the data type of the field selected. Table 1-2 shows the various filters
that you can use at table level according to the data type of the field selected.
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Table 1-2. Access 2007 Table Filters

Data Type Filters

Text Equals, Does Not Equal, Begins With, Does Not Begin With, Contains, Does
Not Contain, Ends With, Does Not End With

Date/Time Equals, Does Not Equal, Before, After, Between, All Dates in a Period

Number/Currency Equals, Does Not Equal, Smaller Than, Larger Than, Between

Basically the user is creating a standard Access query using the criteria to build up the
query. You can open the Query window to view the process by clicking the Data tab and select-
ing Advanced ➤ Advanced Filter/Sort.

Complex filters can be created directly at the table level by users. The ability to save a
complex filter as a stored query is another neat feature of the new filter ability. Once you have
filtered a table, select Save As from the File menu and save the filter as a query. The under-
lying SQL used to filter the table will now be available to you.

The Create Ribbon also provides a new feature in Access, Table Templates, which allows
you to choose from a small number of prebuilt table designs. From an Access viewpoint, they
can be badly designed. For example, the Task table template includes field names such as %
Complete; note the use of the wildcard symbol in the table name and that almost every field
contains spaces in field names. The first job therefore for anyone using the templates will be
to change most, if not all, the field names to meet proper design standards. Of course, the
reason the tables are designed this way is to enable easy integration with SharePoint.

Access 2007 Forms
Wow! Where to start with forms? There are lots of changes as far as forms are concerned, from
new properties to a whole new way of designing and working with objects. Some of the new
features are useful, some not. You have the ability to work with a form design while viewing
data. Through the Create tab, the following menu options are available:

• Basic Form: A standard Access form.

• Split Form: A new form containing a datasheet at the top and a standard Access form at
the bottom. The top of the screen displays multiple records, while the form section
shows the detail.

• Multiple Items: Standard continuous form.

• Pivot Chart: Pivot table–type chart based on the underlying record source.

• Blank: A standard blank disconnected form.

• More Forms: Pivot table, modal form, and datasheet. Also gives you access to the Form
Wizard.
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■Note When displaying an attachment data type via forms, the attachment is represented by an icon
within an object frame. For example, a Word document attachment will be represented using the MS Word
icon. Double-click the icon to open the Attachment dialog box. A small floating toolbar is also available to
enable you to move through the attachment files.

Form Layouts
You now have three options for how you want to work with forms: Layout view, Design view,
and Form view. A layout is used to group like objects together on the form for positioning.
Control objects can then be manipulated as a group. Control objects can be detached from
their layout group and repositioned elsewhere on the screen. Select an object, right-click, and
select Remove From Layout on the context menu. Figure 1-7 shows the Formatting Ribbon,
which contains this and other layout options when you are in Layout view.

Another neat feature added to forms is the ability to add existing fields while in Design
view mode (by clicking Add Existing Fields from the Tools group). This feature reminded me
of Data Access Pages (DAPs) in which fields are available within a tree view, and you can drag
and drop fields from tables onto the form background. Once a field is selected and dragged
onto a form, all nonrelated tables are removed from the tree view and the record source of
the form is set to a SELECT statement. Figure 1-8 shows the new Field List Pane. In this case, 
I have clicked the Show all tables link located at the bottom left of the pane. Note this text is
dynamic and will change to read Show only fields in the current record source.

Rich text support has also been added within forms, such as the PDF support mentioned
earlier, removing the requirement to purchase third-party add-ins for this release. Rich text is
available as a field property in the Design view of a table for memo data types only. To activate
rich text, select a text field in Table Design view, select Text Format in the field properties, and
select Rich Text. Once the property has been set at the table level, you use a small floating 
toolbar to format the text within the control in Form view. You may also use the formatting
options on the main Ribbon. Rich text support is provided using HTML mainly to ensure sup-
port when the data is moved to SharePoint Server. Figures 1-9 and 1-10 show the Design and
Layout Ribbons and their associated tools.
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Rich text format is a nice idea; however, at the time of writing, the floating toolbar is dif-
ficult to see but fairly easy to use, and personally I always use the main Ribbon. But that’s a
minor issue compared to the functionality it gives the user and is in keeping with the appar-
ent decision by Microsoft to reduce dependence on third-party tools when working with
Access 2007.
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New Form Properties
Table 1-3 lists the new form properties available with Access 2007. As you can see, many of
these properties are related to the additional ways in which forms can be presented to the
user, for example, split-view forms.

Table 1-3. New Form Properties

Tab Property Comments

Format Split Form Orientation Options are On Left, On Right, Top, Bottom.

Format Split Form Datasheet Options are Allow Edits, Read Only.

Format Split Form Splitter Bar Options are Yes, No.

Format Save Splitter Bar Position Options are Yes, No.

Format Split Form Printing Options are Form Only, Datasheet Only.

Format Navigation Caption Free text caption for navigation buttons.

Data Filter on Load Options are Yes, No. (Applies filter on form load.)

Data Apply OrderBy on Load Options are Yes, No. (Applies OrderBy to Form start-up.)

Event After Layout Options are VBA, Macro for Pivot Table AfterUpdate
Event.

Event Before Render Options are VBA, Macro for Pivot Table BeforeRender
Event.

Event After Render Options are VBA, Macro for Pivot Table AfterRender
Event.

Event After Final Render Options are VBA, Macro for Pivot Table
AfterFinalRender Event.

Other RibbonName Loaded Customization Ribbon ID for On Open.
Use Default Paper Size Options are Yes, No.
Display on SharePoint Site Options are Do Not Display, Follow Table Settings.

List Items
A new feature behind lists is the ability to use object properties to open a form, which enables
users to edit list items. This works in much the same way as a Not In List event (which is still
available); in this case, an object property, List Items Edit Form, is used, which is the form to
open if a value entered is not already available in the list. You still need to code the form and
repopulate the combo box with the newly added value. Another property, Allow Value List
Edits, permits users to add or edit values to an object’s value list. A new dialog box, Edit List
Items, is opened to allow this.

Reports
Just like Access forms, reports now permit design changes in Data view, filtering in Design
view, and interactive grouping. It’s also possible to build clickable reports with a drill-down
capability using the new report On Click event. An example of this is shown in the Issues
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template: clicking a contact name in the report opens the contact form in response to the 
On Click event. The Issues template is available when you create a new database and can be
selected in the opening splash screen. Report objects now have the following events available:

• On Click

• On Exit

• On Got Focus

• On Lost Focus

• On Click

• On Dbl Click (Double Click)

• On Mouse Down

• On Mouse Move

• On Mouse Up

• On Key Down

• On Key Up

• On Key Press

Macros
As mentioned earlier, macros have received considerable focus with this release of Access,
perhaps on a par with SharePoint and the focus on the power user experience. Several new
macro-specific features have been added, and as you may already know, all of the Microsoft
template databases contain no VBA in the form control events—they are all macro driven.
One of the first areas you might notice the use of macros is in the Command Button Wizard,
which, rather than produce VBA, will create an embedded macro. The following is the macro
added by the Command Button Wizard to open a form:

OpenForm
Assignment List, Form, , , , Normal

The use of macros by wizards to create an embedded macro (that is, the macro is now
saved with the form and can be copied between objects as opposed to appearing in the
Navigation Pane and in the event property) is a major departure for Microsoft. One advan-
tage is that such macro-driven functionality will work in a database with code disabled. 
Oh, and before I forget, I better mention macro error control. Yes, Microsoft has added error
trapping to macros! The new OnError feature is much like its equivalent in VBA and allows
you to totally ignore the error using the Next action. The Fail action reverts back to no error
control, and your execution halts in its tracks, much like the original action of a failed
macro. With the Macro Name action, the OnError feature of the macro will pass execution 
to a named label. However, if your error-handling macro fails, it’s back to normal behavior,
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and the whole show stops working! Another new feature, and one which may prove more
useful to developers, is that of temporary variables, or TempVars. TempVars are a variant
store, and they exist during the lifetime of the application. Many developers avoid the use 
of variants, as they can add additional overhead to executions, and prefer to explicitly
declare variable data types. TempVars have .Value, .Remove, and .RemoveAll properties and
could prove useful to store values required elsewhere in code during execution. TempVars
provide you with an enumerated collection when you work in VBA and can be used to store
data only.

Within a macro, TempVars can be used as local variables to hold values, for example, 
a form to open or a report to print. They can also be passed between macros and VBA,
although many developers will simply use them within macros.

Modules
At long last, developers can use a wheel mouse within the VBA IDE. That’s about it for the
VBA interface. Other than the mouse wheel, modules remain much as they were in Access
2003.

Working with SharePoint Server
SharePoint is one area where a lot of effort has been made by the Access development team
into improving both the user and the developer experience. For users, Access can act as a
front-end interface to data held on SharePoint Servers. Chapters 9 through 11 look at using
SharePoint in some detail and provide a solid overview of what in my view is a great collabora-
tion and development environment not only for Access, but also for the entire Office suite of
applications.

For many Access developers, SharePoint will be something they have read about on
MSDN or heard briefly mentioned. It’s my own belief that SharePoint may well become the
data store of choice for many smaller business groups as well as seeing increasing use in larger
organizations. SharePoint is a huge product and offers substantial scope for developers, par-
ticularly those who would like to move into the world of .NET. As I have already stated, the
tracking application templates provided are designed with SharePoint interaction in mind.
Such applications also fit in with the new Office Live service being offered by Microsoft. Share-
Point is a free downloadable component for the Windows Server 2003 operating system and
provides an Internet development environment based on the .NET Framework 2.0. Windows
SharePoint Services Version 3 can be downloaded from the Microsoft web site. Within Access
2007, it is possible to

• Link to a SharePoint list.

• Upsize your Access database to SharePoint.

• Take SharePoint data offline for remote use.

• View document version history and auditing information via SharePoint lists.
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■Note For the examples later in the book, you will require access to a SharePoint site. For those really
keen, this is actually possible using freely downloaded software: Windows Virtual Server 2005, an evaluation
copy of Windows Server 2003, and Windows SharePoint Services Version 3. Install the software in a virtual
environment and off you go! You will only have a limited amount of time to use the evaluation copy of the
Windows Server 2003 OS before it deactivates. The rest of the software is yours to keep.

The ability to work with SharePoint data offline will be very useful to many individuals
who already work with SharePoint. Using Access, it’s possible to connect to a SharePoint web
site, take a list down to Access, disconnect from the SharePoint Server, and when ready recon-
nect and update your SharePoint list with any changes. Members of staff, for example, could
download lists of data and documents into Access, work on the information offline, perhaps 
at a meeting, and when ready connect and update the central data store.

Given the focus SharePoint has received with this release of Office, I think Access develop-
ers would be well advised to start looking at what this product brings to the game in terms of
functionality and .NET coding. Chapter 9 looks at SharePoint in some more detail and hope-
fully will encourage you to take a close look at this software, remembering that Windows
SharePoint Services is provided free of charge, and all you need is Windows Server 2003.

Security
The biggest blow to many developers will be the removal of user-level security in the new file
type. User-level security is supported for MDB files but not ACCDB files. It would appear to be
the Microsoft view that user-level security wasn’t actually intended to be used for security but
rather for custom navigation! The new file type has had security increased using an encrypted
database password, which is no longer stored in the database. Support for user-level security
will be maintained for earlier versions of Access.

E-Mail Data Collection
Using Access 2007 and Outlook 2007 (to process the replies), it is now possible to issue an
InfoPath form, or HTML form, to users, have them complete the form, reply to the e-mail, and
automatically update an Access table with the returned data. Users will need Microsoft
InfoPath installed in order to respond if you are using the option to send the request using
InfoPath forms; otherwise, standard HTML forms will not be an issue. E-mail data collection
and Microsoft InfoPath are discussed in Chapter 4.

Summary
Overall, many new features have been added to Access 2007, some of which will prove useful,
and others, as is the nature of things, will make your life as a developer a little bit more com-
plex. The focus of SharePoint Services could fundamentally change the way in which we as
developers and power users interact with data, building rich interactive applications. As you
progress through this book, I hope you can get a sense of where Access is going and pick up
some of the skills necessary to fully enjoy the journey.
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